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Summary

This technical note shows how to send HTML emails with embedded pictures. It is
possible to send automatically created daily or weekly sales reports to a management
group. The HTML text can be created using a HTML template. The HTML text can also
be created without any HTML knowledge by using 4D’s Quick Report engine.

About HTML emails

HTML formatted emails is a complex topic. This tech note focuses on automatically
created emails. If you are looking for a HTML editor to allow your customers to enter
or edit HTML documents, look at "4D Email 3.0”, a new 4D 2004 based email client
using the MarketBlast HTML Plug-in, which is currently in Beta.

HTML emails may either refer to external pictures or use internal references to file
enclosures. Almost all advertising emails (SPAM or subscribed email services) use
references to pictures on a normal web server. The major benefit is drastically
reduced transfer volume. It is possible to detect if the user reads the email, because
the picture loads from a server. As a result, more and more email clients do not
download pictures to protect the privacy of users.

A clever way to send the picture is to include it as an enclosure and refer to the

picture in the embedded document. The direct benefit is that all mail clients
automatically display the picture, which makes a sales report more reliable.

About the example

The example database sends an automatic sales report containing: a statistic about
customer sales, a pie chart showing sales grouped by ZIP code, a statistic based on
product codes and a chart grouped by product code. The charts are created using 4D
Chart which returns a picture; the picture is converted to GIF.

The example shows ways to produce the HTML statistic. The first way is easy to use,
which is based on 4D’s Quick Report engine. By using the Quick Report, the 4D
developer or even his customer can produce a statistic without any HTML knowledge.
The second way is more complex because it uses a HTML template (provided by the
4D developer or modified by a HTML designer) and the new 4D 2004 command,
PROCESS HTML TAGS, to create the final HTML report.



Finally the four parts (two statistics and two pictures) are merged together in a
template with PROCESS HTML TAGS and the result is sent using 4D Internet
Commands.

The created report looks like this:

4D Sales Report - 22.08.2005

This iz an example sales report created by dth Dimension.

Customer Sales Statistic

Company Zip Price
Grace Medical Associates 95128 15.600,00
Grace Medical Associates 95128 103.650,00
Zip Subtotal 95128 119,250,000
The Cup and Saucer Cafe 98104 7.040,00
Zip Subtotal 104 704000
Edwards, Berry, and Tuft LLP 95118 7.000,00
Zip Subtotal 95118 7.000,00
Zeaside Lodge 95128 21.355,00
Zip Subtotal 95128 21.3%95,00

|| 154.685,00]

W 95115 san Jose
[ 95128 $an Jose
W 99104 Seattle

Product Sales Statistic



Using the example

Start the example and a welcome dialog opens. The next screen allows you to try the
example:
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To send an email yvou need to enter the following data:

EMail Server: rrail.de. 40 corr| mail.company.com
Sender: Thomashaulifgde.4D.com name@eompany.cam
Receiver: Thomasmaul@de.40.com name@company.cam

For testing you should use your own address as sender and
receiver. Use a""to separate several receivers.

SMTP User D Thomashiaul Ifyaur Mail Server requires SMTP
Authentification: enter
TEEEEEEEEE
UszerlDiPassword

‘ Use GQuick Report ‘ ‘ Llse HTML Template

To setup the program, you need to enter the usual information needed for an email
client. The name (or IP address) of your mail server is needed. If your mail server
requires SMTP authentication you need to enter your account ID and password.

Passward:

For testing we suggest to use your email account for sender and receiver.

Both buttons “Use Quick Report” and “Use HTML Template” automatically creates a
report and sends it. Both reports contain the same data, but uses different colors and
styles.



Customizing the report

The next chapter explains how to customize the report and use it in your own
application. First, we change the report in the Invoices example database. Second, we
explain how to add code to your own application. Finally, we show how you can allow
your customer to modify the report.

Customizing the Quick Report statistic

Close the demo window by using the close button.

1- Switch to User mode and select Invoices from the list of tables.

2- Open the Quick Report window.

3- Design a new report. You may design the report manually, using all features of the
Quick Report engine, or ask the wizard (button on the right side) to help you.

4- Check the report with Print Preview from the File Menu.

5- Switch to Wizard mode, even if you are finished designing the report.

6- Click the “Next step” button in the lower left corner until you reach, "6 - Output
Type”.

7- Select “"HTML file”.

8- Click the “Next step” button. In “7-Presentation” you may want to add some colors.
9- Click “Next step” to reach the “8-Finalization” step.

10- Click the button, “"Build 4D Code”. This is a new feature in 4D 2004. This button is
only available in uncompiled databases in User mode.

In “Code Options” select all check boxes. Click the “Build code” button.

iZode Options

-

<

N J [¥]Barders
% Palettes visibility
~J [ Test properties
[¥]Fant, Size, Justification
| Build code | Style (Bold, Italic, Underline)
[¥] Colar (Text, Background)
Paste in Clipboard
C_LONGINT($1) -

C_LONGINT($ID)
$IDi=$1

QR SET DOCUMENT PROPERTY($10;1;0)
QR SET DOCUMENT PROPERTY($ID; 2;0)
QR SET REPORT KIND{$ID;ar list report)

QR SET DESTINATION(ID; qr HTML file;™)

Fmodel_html:="

#model_html:=$model_html+"<html="

#maodel_html:=$model_html+"  <head>"

#model_html:=$model_html+"  <meta http-equiv=\"Content-Typel" content=\"text/html;charset= <1--#4DQRCharSet-- =" ="
#model_html:=fmodel_html+" <fhead="

4model_html:=$model_hbmi+"  <body bgeolor=\"#FFFFFFY" bext=}"£000000}" ="

#model_html:=$model_html+"  <table border=1="

4model_html:=$model_hbmi+"  <1--#4DGRHeader—=" =
S S D St e

Dang

This feature creates 4D code which builds the report you just clicked, using the
programming language!

11- Finally, click the button, “Paste in Clipboard”, then close the dialog and close the
quick report.



12- Switch to Design mode and create a new method named, “Mail_Report_test1”.
Use Edit/Paste from the menu bar to insert the automatically created code in your
method.

The code is nearly ready. We need to make two modifications.
Line 9 contains the code:

QR SET DESTINATION($ID;qr HTML file ;™)

Change it to:
QR SET DESTINATION($ID;gr HTML file ;$2) " replace the last parameter “” with $2

13- Finally, in the Edit menu, select Find the choose Replace. Enter in “Find What”:
=\" and “Replace with”: =3D\”

m Find and Replace

r ______ Replace in Method
”“% Find What: - .
Replace with: =30\ .

Cpkions Search Direction

[ whale Ward () Previous
[] Case Sensitive (%) Next

[ Cancel ] Everywhere ] Replace |

Now click the “Everywhere” button.

4D Quick Report creates a HTML template to be used with Web browsers. To use the
HTML template as HTML mail we need to do the replace modification. You can find
background information about the modification in the last chapter “Inside multipart
MIME mails”.

Now try your own report. Open the method “Mail_CreateReport”. Replace in line 15
the method “Mail_Reportl” with your new created method “Mail_Report_test1”.

That's it. Now switch back to Custom Menus and start the demo by selecting HTML
Mail from the File menu. If you haven't already, enter your mail settings and click the
button “Use Quick Report”.

You will receive an email with the new report.

Sending HTML reports from your application

To send HTML reports from your application, you only need to install a single method!
Switch back to design mode and open the method "HTMLMail_send”. Select Export
Method... from the Method menu to save the method to your desktop.

Quit 4D.



If your application does not use 4D Internet Commands, install the plug-in. Start your
application and enter Design mode.

Create a new method and name it "HTMLMail_send”.

Use Import Method... from the Method menu and select the exported method.

Close the new method.

Open the “Invoices” example folder and the folder "HTML_Mail_Template” (using
Explorer or Finder). Locate the file “1report.txt” and place a copy of the file next to
your structure. Rename it “htmlmail_template.txt".

This file contains the HTML code to build an embedded html email with 1 or 2 reports
with 0, 1 or 2 pictures. We explain in a later chapter how to customize these
templates.

Follow the steps from the previous chapter and create a method named
“Mail_Report_testl” with the code to create the Quick Report HTML statistic for a table
in your application, like Invoices.

Finally create a test method to start the job. For testing we will use hard code. For use
in a production environment, you would add a user interface or automate the job in a
server process which runs automatically each night.

HTMLMail_Title:="This is the title of our mail"
HTMLMail_Text1:="We created this mail to show how the tech note works."

$qgreport:=QR New offscreen area

QUERY ([Invoice];[ Invoice]Day>(Current date-30)) " replace this with your table/field names
$path:="HTMLMail_Report1.html"

Mail_Report_test1 ($qreport;$path)

QR EXECUTE COMMAND($qgreport;qr cmd new )

QR DELETE OFFSCREEN AREA($qgreport)

Serr:=HTMLMail_send ("ThomasMaul@de.4D.com";"ThomasMaul@de.4D.com";HTMLMail_Title;
"mail.de.4D.com";"userID";"password")

First, we hard code the content of the title and text. Second, we build a selection of
usable size (if you have few records you can simply call ALL RECORDS). Lastly, we
send the mail by directly entering receiver, sender and password. Once it works as
expected, you should replace the hard code with variables, so users can modify it.

Try it. You will receive an email with your created report, formatted as HTML. Yes, it's
that simple!

Include pictures

Statistics are easier to understand if business charts are included. So the next step is
to include a picture.

Business charts can be dynamically created using 4D Chart. There are several ways to
do that, many tech notes were already published for this topic. The example code also
contains two examples to automatically build a chart.



We start with a static picture in the HTML mail and later replace this picture with a
dynamically created chart. If you already have a chart area and want to use it, simply
use the command CT Area to picture.

If not, check your picture library in the Toolbox. The picture library usually contains
some button pictures. Note the number of the picture (you may also insert a new
picture).

Insert this code before the last line (HTMLMail_Send):

C_PICTURE($mypict)

GET PICTURE FROM LIBRARY (851;$mypict)

PICTURE TO GIF($mypict;HTMLMail_Pict1Base64) " convert 4D picture to plain GIF, result is a blob
ENCODE(HTMLMail_Pict1Base64) " convert blob in Base64 encoding

We read the static picture (later you replace this line with code to create the picture
dynamically), convert it into a GIF (business charts usually use 256 colors or less, so
GIF is the best format) and encode it in base 64 format.

The last step requires the use of a template which supports a picture.

Open the “Invoices” example folder (using the Explorer or Finder) and the folder
“HTML_Mail_Template”. Locate the file “1reports_1picture.txt” and place a copy next
to your structure. Rename it “*htmImail_template.txt” (replace the previous file).

Execute your method. You will receive the report with the picture below.

More statistics — more pictures — customize the email

The next step is to include several statistics in one email or to include more than one
picture. To have 2 statistics with 2 pictures you can simply use the template
“2reports_2pictures.txt” — or customize the template on your own. We will show you
how to customize it, based on the template we are currently using. Open the file
“htmlImail_template.txt” in your structure folder with a text editor.

Don't be afraid. It looks complex but you can ignore most stuff. If you are interested
in details, the last chapter “Inside multipart MIME Mails” explains the content.

In the middle of the document you will see:

<!--4DInclude HTMLMail Reportl.html-->

<P><BR></P>

<IMG align=3Dbaseline border=3D0 hspace=3D0=20
src=3D"cid:001@<!--4DVar HTMLMail MailID-->">

The first line includes the report created by 4D Quick Report. The second line is an
empty line. The last line includes the picture.

If you want to add another report, copy the first line and insert it after the picture.
Rename the included document to HTMLMail_Report2.html.



In 4D create another report. Save the report as a method and duplicate the code
fragment which runs the Quick report. For $path use the same name as above,
HTMLMail_Report2.html. That's it.

If you know HTML you can also modify the HTML document, like add more body text
or change the format.

To use another picture copy the <IMG...> line and insert it at the position where you
want the new picture to be displayed. This line contains the link cid: followed by the
number 001. Replace it with 002 (and so on). Do not change numbers before the 4D
HTML Tag because the numbers are needed to build a unique ID.

Finally we need to insert another picture. Scroll to the end of the document. You will

see this section:
—————— = NextPart 001 <!--4DVar HTMLMail MailID-->
Content-Type: image/gif;

name="Pictl.gif"
Content-Transfer-Encoding: base64
Content-ID: <001@<!--4DVar HTMLMail MailID-->>
Content-Description: Pictl.gif
Content-Disposition: inline;

filename="Pictl.gif"
Content-Location: Pictl.gif

<!--4DHTMLVar HTMLMail PictlBase64-->

Duplicate the whole section. Replace in Content-ID the humber 001 with 002 (and
similar for more pictures).

Replace the picture name “Pictl.gif” with “Pict2.gif” (you may also choose other
picture names, but the names must be unique). Finally replace the name of the 4D
variable HTMLMail_Pict1Base64 with HTMLMail_Pict2Base64.

In your 4D method, create another variable with HTMLMail_Pict2Base64 and you are
finished.

Allow the end user to modify the report

Another way is to allow the end user to create and modify the quick report. You can
do this either by opening the Quick Report editor or including the quick report in a
form. The created quick report is saved as an external document or as a blob.

In the previous example, you open an off-screen area and use QR BLOB TO REPORT
to use the created report. Copy from the example database method
“Mail_Report_testl”, the lines between QR SET DESTINATION and QR SET HTML
TEMPLATE into your code. Finally execute the code using the QR RUN command.

This combination allows the user to freely design the report. You can
programmatically check that the report destination and report HTML template is
correctly set. Everything else works like in the previous example.



Fully customizable HTML reports

Instead of using 4D Quick Report to build the HTML report, you can have total control
and build the report manually. To do this, you should have basic HTML knowledge and
be familiar with 4D HTML Tags. Check the 4D 2004 Language Reference, Web Server
chapter, 4D HTML Tags sub chapter for more information.

Example code is found in the “Mail_ManualReportl” method of the example Invoices
database. Instead of using code created from Quick Report we create this code
manually. You can use the sample method as a guide.

The code creates 4 arrays which contains the data (detail, header, subtotal and total
lines) to be used in the report.

Then it uses the command PROCESS HTML TAGS to create the HTML report using
these arrays. If you know how to use HTML tags this is an easy way to create complex
HTML reports.

Inside multipart MIME Mails

The following information explains how HTML mail with embedded pictures works. You
do not need to read this chapter to use the code! If you used HTML and 4D’s HTML
tags before, this chapter may provide interesting background knowledge.

The best way to understand this concept is to first send mail using the example. After
doing so you will find in the example folder a document named “htmltest.txt”, which is
created for debugging/learning purposes. It contains the source code of the sent
email. Open the document with a text editor.

You will notice that it is structured in several parts, all divided by a header looking like
T =_NextPart...."”.

Not included in this document is the SMPT Header of the mail itself, which is:
Content-Type: multipart/related; boundary="------ =_NextPart....”

The header tells the mail client that the mail consists of several parts and how the
separator looks like. The first part of the mail (without any additional header) is the
text only part of the mail, which is displayed from a mail client that does not support
HTML mails. This part is returned if you receive the mail using 4D Internet command
MSG_GetBody.

To reduce the complexity of this example we simply use the constant text “This is a
multi-part message in MIME format” as the text only part.
A better solution would be to add a text only copy of the report in this section.

Now it’s time to have a closer look at the NextPart divider. It starts with a numeric ID
" _001_" and then a unique identifier, which is composed of the current date and time
(using tick counts). The unique identifier is calculated for each mail, while the rest is a
static template.



The first section refers to a subsection, starting with _002_, which contains the real
HTML section of the mail. The “header” of the section informs the mail client about the
character set and the encoding to use. For now, skip the entire HTML section. We will
come back to this section later. We will take a look at the next sections.

The next two sections look very similar — and very cryptic. As you can guess from the
header, these two sections contains the pictures. The picture must be encoded in
base64.

The header informs the mail client that the content is an image in “gif” format,
encoded as base 64, with the name “Pictl.gif”. The header also contains “content-ID",
which is needed in the HTML section to refer to the embedded picture.

Now scroll back to the HTML section. You will notice that it looks like a normal HTML

page, except two differences. Some commands looks strange, like:
<div align=3D"right">

Because the text is formatted as “quoted-printable” we need to replace all “=" with
“=3D". 3D is the hex code of the “"=" character.

The second difference is the image:
<IMG align=3Dbaseline border=3D0 hspace=3D0=20
src=3D"cid:001@22.08.2005_63125777">

Again we have used the "=3D" combination. The source is not a normal URL but an
internal reference; it is the content-ID we saw in the picture section.

The format of a HTML mail is quite simple. You can put almost any HTML code inside
the HTML section, but need to replace “=" with "=3D". If you want to refer to images,
you may either use external URL’s or link to embedded pictures. In this case the
picture must be placed at the end of the mail, each in its own section, each with its
own Content-ID. The Content-ID is a counter (001, 002, and 003) followed by a
unique ID (we use again current date_tick count).



